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Welcome to Norstar Voice Mail Desktop 
Messaging

About Norstar Voice Mail Desktop Messaging

Norstar Voice Mail Desktop Messaging gives you access to voice messages from your 
personal computer. You can manage all your voice, fax and e-mail messages in one 
graphical interface. You can access your mailbox from your telephone at any time.

In Norstar Voice Mail Desktop Messaging, you can send and receive messages that include 
any combination of voice, fax and text. Here are some of the many ways you can use 
Norstar Voice Mail Desktop Messaging:

• Listen to voice messages

• View and print fax messages

• Record and send voice messages

• Create and send fax messages

• Forward and reply to voice and fax messages

• Add message options such as urgent and private

• Add voice, fax or text file attachments to messages

• Create personal distribution lists

• Change your password

Refer to the online Help available with Norstar Voice Mail Desktop Messaging for detailed 
information not covered in this Quick Reference Guide.

This Guide shows examples in Microsoft Outlook. The way your screen looks can vary in 
Microsoft Exchange.

System requirements

To record and play Norstar Voice Mail Desktop Messaging voice messages from your 
computer, you computer must have:

• a sound card

• a microphone

• speakers

To use any of the fax options, your system must have the Norstar Voice Mail FAX option 
installed. Ask your System Administrator to install this option.
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Logging on

Use your Enterprise Edge password to log on to Norstar Voice Mail Desktop Messaging.

Remote log on
You can log on to Norstar Voice Mail Desktop Messaging from another computer, such as 
your laptop, if Norstar Voice Mail Desktop Messaging is installed and configured in the 
same way as your office computer. You can work offline and use a dial-up connection to 
reach the server.

To log on from your PC

1. On your desktop, click the Microsoft 
Outlook icon.
The Nortel Messaging Logon dialog 
box appears.

2. In the Mailbox box, type your 
mailbox or extension number.

3. In the Password box, type your 
password.

4. Click the OK button.
The Microsoft Outlook window 
appears.

Shortcut log on

1. Right-click the mailbox icon on the 
Windows taskbar and then click 
Open Inbox.
The Nortel Messaging Logon dialog 
box appears.

2. In the Mailbox box, type your 
mailbox or extension number.

3. In the Password box, type your 
password.

4. Click the OK button.
The Microsoft Outlook window 
appears.
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Changing your Enterprise Edge Voice 
Messaging password

You can change your Enterprise Edge password from Norstar Voice Mail Desktop 
Messaging.

To change your Enterprise Edge 
password from Microsoft Exchange 
or Microsoft Outlook

1. On the Outlook window, click Tools 
and then click Norstar Mailbox 
Manager.
The Norstar Mailbox Manager 
window appears.

2. Click the Password tab.

3. In the Current Password box, type 
your current password.

4. In the New Password box, type your 
new password.

5. In the Verify Password box, type 
your new password.

6. Click the OK button.
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Norstar Voice Mail Desktop Messaging for 
Microsoft Exchange and Outlook

When you open Microsoft Exchange or Microsoft Outlook, display your Norstar Voice 
Mail Desktop Messaging messages by clicking the Inbox icon under the Nortel Networks 
icon. From the Inbox you can move, copy and delete messages, and create new messages.
 

When you 
delete a 
message, it 
is moved to 
Deleted 
Items. To 
delete 
messages 
completely, 
empty the 
Deleted 
Items folder. 

Nortel 
Folders 
conta in your 
received, 
sent and 
deleted 
Norstar 
Voice Ma il 
Desktop 
Messaging 
messages

Date and 
time 
received

Subject 
shows the 
sender’s 
phone 
number, 
and if the 
message is 
voice, fax 
or text. 

To open a message, 
double-click the 
message icon

N ew messages 
appear in bold

Click the N ew Ma il 
Message icon to 
create a new message

A paperclip means that 
the message has an 
attached file

An exclamation mark means that 
the message is urgent

Click the Address 
Book icon to access 
the address books
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Reviewing your messages

To play Norstar Voice Mail Desktop Messaging voice messages from your computer, your 
computer must have a sound card and speakers.

Message notification
When you have a new message the mailbox icon on your Windows taskbar displays an 
exclamation mark. 
After you play your message, the exclamation mark disappears.
 

The Nortel Voice Player

To play a voice message

1. Double-click the voice message icon 
in the Norstar Voice Mail Desktop 
Messaging Inbox.
The message appears in a separate 
window.

2. Double-click the Voice Message icon 
to play the voice message.
The Nortel Voice Player appears.

Fast forwards 
the message

Plays the message

Pauses the 
message

Stops playing the 
message

Downloads and 
plays the voice 
message

Closes the 
Play bar

Rewinds the 
message
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To view a fax message
To view faxes in Norstar Voice Mail Desktop Messaging you must have Imaging for 
Windows installed on your PC. To use any of the fax options, your system must have the 
Norstar Voice Mail FAX option installed. Ask your System Administrator to install this 
option.

While you view the fax, you can enlarge or reduce the image, rotate it, move it, copy it and 
print it.

To view a fax message

1. Double-click the fax message icon in 
the Norstar Voice Mail Desktop 
Messaging Inbox.
The message appears in a separate 
window.

2. Double-click the Fax Message icon to 
view the fax message.

3. Save the fax message to the desired 
location.

4. Double-click the fax message icon to 
open it. The fax message is displayed 
in Imaging for Windows.

Save Print Drag /
scroll

Annotate Zoom in
Zoom out

Rotate left
Rotate right

Magnification Previous page
Current page
N ext page

One page view
Thumbna il view
Page & thumbna il view
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Creating messages

You can create a message that is any combination of voice, fax or text. Your message can 
be a new message, a reply to a received message or an introduction to a forwarded message. 
Before you send your message, you can add attachments and options.

Create a voice message by opening an Norstar Voice Mail Desktop Messaging new mail 
message and recording a message from your microphone. You can send the message or 
save it to send later.

To record and send a voice message

1. On the Microsoft Exchange or 
Microsoft Outlook toolbar, click the 
New Mail Message icon.
A new message window appears.

2. Click inside the body of the message.

3. Click the Insert menu and then click 
Object.
The Insert Object dialog box appears.

4. In the Object Type list, click Wave 
Sound.

5. Select the Create New option.

6. Click the OK button.
The Sound Object dialog box opens.

7. Record your voice message and click 
the Close button to return to your 
message.

8. Click the to button to open the 
address books and address your 
message.

9. Add the attachments and options you 
require. See Adding attachments to 
messages on page 13 and Setting 
message options on page 16.

10. Click the Send icon to send your 
voice message.



10  Creating messages

Norstar Voice Ma il Desktop Messaging Quick Reference Guide P0908824 Issue 01

To save a voice message
You can record a voice message and save it as a file to use later.

1. In an Norstar Voice Mail Desktop Messaging message, record a message.

2. On the File menu, click Save As.
The Save As dialog box appears.

3. In the File name box type a name for the file and in the Save as type list box 
select .rtf.

4. Select a folder to keep the file in and then click the Save button.
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To create and send a fax message
To send a fax, your system administrator must have installed Enterprise Edge FAX 
capability for your mailbox. The recipients of your fax must also have fax capability 
enabled to view the fax on their computer. If your recipients access their messages from 
their telephone, they must print the fax to view it. You can send your fax to a fax machine 
by entering the fax number as the address.

To send a fax message

1. Open the document that you want to 
fax. It must be 8.5 inches wide or 
less.

2. On the File menu, click Print.

3. From the list of printers, select Nortel 
Fax.

4. Click the OK button.
The Compose Fax dialog box 
appears. From here you can view the 
fax, add more documents to the fax or 
save the fax as a file.

5. Click the Send button.
The Optional Voice Annotation 
dialog box appears.

6. If you want to add a voice 
introduction to the fax, click the Yes 
button and record the voice message
or
if you want to send just the fax 
message, click the No button
or
if you want to cancel the fax, click the 
Cancel button.

7. On the Fax Message window, click 
the To button to select a recipient 
from your Personal Address book, or 
type the recipients’s e-mail address in 
the To box.

8. Click the Send icon to send the fax.
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To create and send a text message

1. Open an Norstar Voice Mail Desktop Messaging new mail message.

2. Type or paste text into the message and then click the Send button.

To save a text message

1. On the File menu, click Save As.
The Save As dialog box appears.

2. In the File name box type a name for the file and in the Save as type list box 
select .rtf.

3. Select a folder to keep the file in and then click the Save button.
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Forwarding and replying to messages

You can forward a message and create an introduction to send with it. You can create a 
reply to the sender of a message, or to the sender and all recipients of a message.

To forward or reply to a message

1. Open the message you want to forward or reply to.

2. If you want to forward the message, click the Forward icon and address the message
or
if you want to reply to the sender of the message, click the Reply icon 
or 
if you want to reply to the sender and all the recipients of the message, click the 
Reply to all icon.

3. Click the Send button.

Adding attachments to messages

Before sending a message, you can attach a voice, fax or text file to it. Text files must be 
.txt files and fax files must be .tif-f files. 

To attach a file to a message

1. In an open message, click the Insert 
File icon.
The Insert File dialog box appears.

2. Type the name of the file that you 
want to attach in the File name box 
and click the OK button, or double-
click the file’s icon to attach it.

3. In the Insert as option, select 
Attachment.

4. Click the Send icon.
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Addressing messages

With Norstar Voice Mail Desktop Messaging you can address a message by selecting a 
name from the Nortel Address Book or your Personal Address Book. Your Personal 
Address Book can include distribution lists and names.

To add a Nortel Address Book 
address to your Personal Address 
Book

1. On the Microsoft Outlook or the 
Microsoft Exchange toolbar, click the 
Address Book icon.
The Address Book dialog box 
appears.

2. In the Show Names from the: list 
box select Nortel Address Book.

3. Select the name you want from the 
Nortel Address Book and click the 
Properties button.
The Properties dialog box for the 
name you selected appears.

4. Click the Personal Address Book 
button and then click the OK button 
in the next two dialog boxes to add 
the name to your Personal Address 
Book.
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To address a message from the 
Nortel Address Book or your 
Personal Address Book

1. On the Microsoft Outlook or 
Microsoft Exchange toolbar, click the 
Address Book icon.
The Address Book dialog box 
appears.

2. In the Show Names form the list box, 
select Nortel Address Book or 
Personal Address Book.

3. Select the name of the recipient or a 
distribution list.

4. Click the To button.

5. Click the OK button to return to the 
message window.
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Setting message options

From a Norstar Voice Mail Desktop Messaging message window you can set priority, 
sensitivity and delivery options.

On the open message window click File and then click Properties.
The Properties dialog box appears.

Sets the value of the 
message to Low, 
Normal or High 

Notifies you when 
the message has 
been read

Notifies you of 
delivery

Saves a copy of the 
message to your Sent 
Message folder

Sets the sensitivity of 
the message to 
Normal, Personal, 
Private or 
Confidential
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Creating personal distribution lists

You can create a personal distribution list for a group of persons that you often send 
messages to. After you create a list, it appears in your Personal Address Book. When you 
want to address a message to the group, select the list..

To create a personal distribution list

1. On the Microsoft Outlook or 
Microsoft Exchange toolbar, click the 
Address Book icon.
The Address Book dialog box 
appears.

2. Click the New Entry icon.
The New Entry dialog box appears.

3. In the list of entry types, select 
Personal Distribution List and click 
the OK button.
The New Personal Distribution List 
Properties dialog box appears.

4. In the Name box type the name of the 
distribution list.

5. Click the Add/Remove Members 
button and type or select members 
from the list to add to your new 
personal distribution list.

6. Click the OK button in the current 
and the next dialog boxes to create 
your new personal distribution list.


